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Problem Specification 

 

Consider a fluid flow through a sudden expansion in an axisymmetric pipe. The 

flow is laminar and axisymmetric. Due to symmetry, the computational domain 

covers only half of the pipe. BD is the axis of symmetry.  The radius R1 = 1m 

and R2/R1 = 2.   

L1/R1 = 20 and L2/R2 = 50. The inlet velocity at AB is uniform, U1 = 1. m/s. 

The fluid exhausts into the ambient atmosphere which is at a pressure of 1 atm 

at CD. The density ρ = 1kg/m3 , and the dynamic viscosity is: 

µ = 3.61x 10 -2kg/(ms). 

The Reynolds number Re at AB = (2 R1 ρ U1) /µ = 55.4. 

This Re value is selected to match one of the experimental cases in the paper 

by Hammad et al. (1999).  

Use FLUENT via ANSYS Workbench to predict the flow and validate your 

results by comparing them with those in the following journal papers: 

1- Macagno, E. and  Hung, T-K. “Computational and experimental 

study of a captive annular eddy”, J. Fluid Mech. vol. 28  (1967) 

pp. 43-64. 

2- Hammad, KJ,  Otugun, MV and Arik, EB “A PIV study of the laminar 

axisymmetric sudden expansion flow”, Experiments in Fluids 26 (1999) 

pp. 266-272. 
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Step 1: Pre-Analysis & Start-up 

Preliminary Analysis 

The computational domain consists of 2 parts: one for the small pipe and the 

other for the larger pipe. In the small pipe, the viscous boundary layer grows 

along the pipe wall starting at the inlet, and eventually a fully-developed 

velocity profile forms provided that the small pipe is long enough. As that flow 

passes through the expansion entrance, a recirculation zone forms in the 

corner of the larger pipe. The flow will become fully developed again after 

sufficient distance downstream from the recirculation zone. 

 

 

We'll create the geometry and mesh in ANSYS 14.0 which is the preprocessor 

for FLUENT, and then read the mesh into FLUENT. 

Start ANSYS FLUENT 

Prior to opening ANSYS, create a folder called pipe in a convenient location. 

We'll use this as the working folder in which files created during the session will 

be stored. For this simulation FLUENT will be run within the ANSYS 

Workbench Interface. Start ANSYS workbench: Start> All Programs> 

Ansys 14.*> Workbench 14.* 

The following figure shows the workbench window.  
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Step 2: Geometry 

Saving 

First, save the project at this point. Click on the "Save As.." button, , 

which is located at the top of the Workbench Project Page . Save the 

project as "suddenExpansionFlow" in your working directory. When you save 

in ANSYS a file and a folder will be created. For instance if you save as 

"suddenExpansionFlow", a "suddenExpansionFlow" file and a folder called 

"suddenExpansionFlow_files" will appear. In order to reopen the ANSYS files 

in the future you will need both the ".wbpj" file and the folder. If you do not have 

BOTH, you will not be able to access your project.  

Fluid Flow (FLUENT) Project Selection 

On the left hand side of the workbench window, you will see a toolbox full of 

various analysis systems. To the right, you see an empty work space. This is 

the place where you will organize your project. At the bottom of the window, 

you see messages from ANSYS. 

Left click (and hold) on Fluid Flow (FLUENT), and drag the icon into the 

empty space in the Project Schematic. Your ANSYS window should now 

look comparable to the image below.  

 

Since we selected Fluid Flow (FLUENT), each cell of the system corresponds 

to a step in the process of performing CFD analysis using FLUENT. Rename 

the project to suddenExpansion. 
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We will work through each step from top down to obtain the solution to our 

problem.  

Analysis Type 

In the Project Schematic of the Workbench window, right click 

on Geometry and select Properties, as shown below.  

 

The properties menu will then appear to the right of the Workbench window. 

Under Advance Geometry Options , change the Analysis Type to 2D 

as shown in the image below.  
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Launch Design Modeler 

In the Project Schematic, double click on Geometry to start preparing the 

geometry. 

At this point, a new window, ANSYS Design Modeler will be opened. You will 

be asked to select desired length unit. Use the default meter unit and 

click OK.  

Creating a Sketch 

Start by creating a sketch on the XYPlane. Under Tree Outline, 

select XYPlane, then click on Sketching right before Details View. This 

will bring up the Sketching Toolboxes . 
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Click on the +Z axis on the bottom right corner of the Graphics window to 

have a normal look of the XY Plane.  

In the Sketching toolboxes, select Rectangle. In the Graphics window, 

create the first rough Rectangle by clicking once on the origin and then by 

clicking once somewhere in the positive XY plane. (Make sure that you see a 

letter P at the origin before you click. The P implies that the cursor is directly 

over a point of intersection.)  

 

Repeat, and create the second rectangle with smaller length and width. Also, 

make sure these two rectangles are connected. At this point you should have 

something comparable to the image below.  

 

The overlapped lines of these two rectangles are extraneous and will be 

removed. Under Sketching Toolboxes , click Modify tab, and cut the line 

indicated by the figure below. This will delete the width of the smaller 

rectangle. 
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Then, trim the width (only the lower part) of the lager rectangle which overlaps 

the small rectangle. You should have the image below.  

 

 

Dimensions 

At this point the rectangle will be properly dimensioned. 

Under Sketching Toolboxes, select Dimensions tab, use the default 

dimensioning tools. Dimension the geometry as shown in the following image.  

 

 

Under the Details View table (located in the lower left corner), set H1=20m, 

H2=100m, V3=1m and V4 = 2m, as shown in the image below.  
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Surface Body Creation 

In order to create the surface body, first (Click )Concept > Surface From 

Sketches as shown in the image below.  

 

This will create a new surface SurfaceSK1. Under Details View, 

select Sketch1 (go to XYplane and expand it to see Sketch1, click on it) 

as Base Objects, and then under Surface body select the thickness to 0.1m 

and click Apply. Finally right click SurfaceSK1 and select Generate to 

generate the surface. You should see “1 part, 1 Body” under SurfaceSK1. 
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At this point, you can close the Design Modeler and go back 

to Workbench Project Page. You should see two green check marks next 

to Geometry and Mesh. Press Refresh Project and Update Project, 

then save your work thus far in the Workbench Project Page.   
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Step 3: Mesh 

In this section the geometry will be meshed. The cell numbers on the edges of 

the desired mesh are shown here: 

 

Launch Mesher 

In order to begin the meshing process, go to the Workbench Project Page , 

then (Double Click) Mesh.  

You may want to generate a preliminary mesh by right clicking on Mesh 

(upper window) and then “Generate Mesh”. 

Mapped Face Meshing 

Here we are interested in creating a grid style of mesh that can be mapped to a 

rectangular domain. This meshing style is called Mapped Face Meshing. In 

order to incorporate this meshing style (Click) Mesh Control > Mapped 

Face Meshing as can be seen below.  

 

https://confluence.cornell.edu/download/attachments/85624045/MenuMappedFaceMeshing_Full.png
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Now, the Mapped Face Meshing  still must be applied to the pipe geometry. 

In order to do so, first click on the pipe body which should then highlight green. 

Next, (Click) Apply in the Details of Mapped Face Meshing  table, as 

shown below.   

 

 

After clicking Apply, you should see “Geometry: 1Face”. Now, (Click) 

Mesh > Generate Mesh  as can be seen below, and generate a rough mesh.  

 

 

 

Edge Sizing 

The desired mesh has specific number of divisions along the radial and the 

axial direction. In order to obtain the specified number of divisions Edge 

Sizing must be used. The divisions along the axial direction will be specified 

first. Now, an Edge Sizing needs to be inserted. First, (Click) Mesh 

https://confluence.cornell.edu/download/attachments/85624045/SelectApply_Full.png
https://confluence.cornell.edu/download/attachments/85624045/MenuGenMesh_Full.png
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Control > Sizing as shown below.  

 

Now, the geometry and the number of divisions need to be specified. 

First (Click) Edge Selection Filter , , in the upper toolbar. Hold down 

the "Ctrl" button and then click the edges AF and BG. Both sides should 

highlight green. Next, hit Apply under the Details of Sizing table as shown 

below.  

 

 

Now, change Type to Number of Divisions  as shown in the image below.  

 

 

https://confluence.cornell.edu/download/attachments/85624045/MenuSizing_Full.png
https://confluence.cornell.edu/download/attachments/85624045/DetSizing_Full.png
https://confluence.cornell.edu/download/attachments/85624045/NumbDiv_Full.png
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Then, set Number of Divisions to 100 as shown below.  

 

Change Behavior to Hard for both Edge Sizing's. 

 

Follow the same procedure as for the edge sizing on the other edges. Make 

sure to (Click) Mesh Control > Sizing  every time. Then, generate the 

mesh by clicking Mesh > Generate Mesh. You should obtain the following 

mesh.  

 

 

Detail around the expansion entrance FG is presented blow. 

https://confluence.cornell.edu/download/attachments/85624045/SetTo100_Full.png
https://confluence.cornell.edu/download/attachments/85624045/BehaviorHard_Full.png
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Mesh statistics can be found by clicking on Mesh in the tree and then by 

expanding Statistics under the Details of Mesh table. It can be seen that 

there are 22000 elements in the mesh above. 

 

Create Named Selections 

Here, the edges of the geometry will be given names so one can assign 

boundary conditions in Fluent in later steps. The left side of the pipe will be 

called "Inlet" and the right side will be called "Outlet". The bottom side will be 

called "CenterLine" and the other edges are called "Wall", as shown in the 

image below.  

 

In order to create a named selections first Click Edge Selection Filter , . 

Then click on the left side of the rectangle and it should highlight green. Next, 

right click the left side of the rectangle and choose Create Named 

Selection as shown below.  
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Select the left edge and right click and select Create Named Selection. 

Enter Inlet and click OK, as shown below.  
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Now, create named selections for the remaining edges and name them 

according to the diagram. Since the “Centerline” consists of two edges thus 

when naming the centerline you should use "Ctrl" to select both parts. For the 

“Wall”, use “Ctrl” to select three edges. 

Save, Exit & Update 

First save the project in the Mesher window. Next, close the Mesher window. 

Then, go to the Workbench Project Page and click the Update 

Project button, .  

If the Progress window shows error message like this: “Model information is 

incompatible with incoming mesh”, right click on Setup in the workbench and 

select “Reset”, then Update Project again.  
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Step 4: Setup (Physics) 

Your current Workbench Project Page  should look comparable to the 

following image. Regardless of whether you downloaded the mesh and 

geometry files or if you created them yourself, you should have checkmarks to 

the right of Geometry and Mesh.  

 

Next, the mesh and geometry data need to be read into FLUENT. To read in 

the data (Right Click) Setup > Refresh  in the Workbench Project 

Page as shown in the image below.  

 

After you click Update, a question mark should appear to the right of 

the Setup cell. This indicates that the Setup process has not yet been 

completed.  
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Launch Fluent 

Double click on Setup in the Workbench Project Page  which will bring up 

the FLUENT Launcher. When the FLUENT Launcher appears change 

the options to "Double Precision", and then click OK as shown below. The 

Double Precision option is used to select the double-precision solver. In the 

double-precision solver, each floating point number is represented using 64 

bits in contrast to the single-precision solver which uses 32 bits. The extra bits 

increase not only the precision, but also the range of magnitudes that can be 

represented. The downside of using double precision is that it requires more 

memory.  

 

 

Twiddle your thumbs a bit while the FLUENT interface starts up. This is where 

we'll specify the governing equations and boundary conditions for our 

boundary-value problem. On the left-hand side of the FLUENT interface, we 

see various items listed under Problem Setup. We will work from top to 

bottom of the Problem Setup items to setup the physics of our 

boundary-value problem. On the right hand side, we have the Graphics pane 

and, below that, the Command pane.  

Check and Display Mesh 

First, the mesh will be checked to verify that it has been properly imported 

from Workbench. In order to obtain the statistics about the mesh (Click) 

Mesh > Info > Size, as shown in the image below.  
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Then, you should obtain the following output in the Command pane.  

 

 

The mesh that was created earlier has 22000 elements. Note that in FLUENT 

elements are called cells. The output states that there are 22000 cells, which is 

a good sign. Next, FLUENT will be asked to check the mesh for errors. In order 

to carry out the mesh checking procedure (Click) Mesh > Check as shown 

in the image below.  
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You should see no errors in the Command Pane. Now, that the mesh has 

been verified, the mesh display options will be discussed. In order to bring up 

the display options (Click) General > Mesh > Display  as shown in the 

image below.  

 

 

The previous step should cause the Mesh Display window to open, as 

shown below. Note that the Named Selections created in the meshing 

steps now appear.  
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You should have all the surfaces shown in the above snapshot. Clicking on a 

surface name in the Mesh Display menu will toggle between select and 

unselect. Clicking Display will show all the currently selected surface entities 

in the graphics pane. Unselect all surfaces and then select each one in turn to 

see which part of the domain or boundary the particular surface entity 

corresponds to (you will need to zoom in/out and translate the model as you do 

this). For instance, if you select wall, outlet, and centerline and then 

click Display you should then obtain the following output in the graphics 

window.  

 

Now, make sure all 5 items under Surfaces are selected. The  button 

next to Surfaces selects all of the boundaries while the  button deselects 

all of the boundaries at once. Once all the 5 boundaries have been selected 

click Display, then close the Mesh Display window. The region displayed 

in the graphics window corresponds to our solution domain.  
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Define Solver Properties 

In this section the various solver properties will be specified in order to obtain 

the proper solution for the laminar pipe flow. First, the axisymmetric nature of 

the geometry must be specified. Under General > Solver > 2D 

Space select Axisymmetric as shown in the image below.  

 

 

Next, the Viscous Model parameters will be specified. In order to open the 

Viscous Model Options Models > Viscous - Laminar > Edit.... By default, 

the Viscous Model options are set to laminar, so no changes are needed. 

Click Cancel to exit the menu. 

Now, the Energy Model parameters will be specified. In order to open the 

Energy Model Options Models > Energy-Off > Edit.... For incompressible 

flow, the energy equation is decoupled from the continuity and momentum 

equations. We need to solve the energy equation only if we are interested in 

determining the temperature distribution. We will not deal with temperature in 

this example. So leave the Energy Equation set to off and click Cancel to 

exit the menu.  

Define Material Properties 

Now, the properties of the fluid that is being modeled will be specified. The 

properties of the fluid were specified in the Problem Specification section. In 

order to create a new fluid (Click) Materials > Fluid > Create/Edit...  as 

shown in the image below.  
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In the Create/Edit Materials menu set the Density to 1kg/m^3 (constant) 

and set the Viscosity to 3.61e-2 kg/(ms) (constant) as shown in the image 

below.  

 

 

Click Change/Create. Close the window.  

Define Boundary Conditions 

At this point the boundary conditions for the four Named Selections will be 

specified. The boundary condition for the inlet will be specified first.  
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Inlet Boundary Condition 

In order to start the process (Click) Boundary Conditions > inlet > 

Edit... as shown in the following image.  

 

 

Note that the Boundary Condition Type should have been automatically 

set to velocity-inlet. Now, the velocity at the inlet will be specified. In 

the Velocity Inlet menu set the Velocity Specification 

Method to Magnitude, Normal to Boundary , and set the Velocity 

Magnitude (m/s) to 0.277 m/s, as shown below.  

 

 

Then, click OK to close the Velocity Inlet menu.  
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Outlet Boundary Condition 

First, select outlet in the Boundary Conditions  menu, as shown below.  

 

 

As can be seen in the image above the Type should have been automatically 

set to pressure-outlet. If the Type is not set to pressure-outlet, then set 

it to pressure-outlet. Now, no further changes are needed for 

the outlet boundary condition.  
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Centerline Boundary Condition 

Select centerline in the Boundary Conditions  menu, as shown below.  

 

 

As can be seen in the image above the Type has been automatically set 

to wall which is not correct. Change the Type to axis, as shown below.  
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When the dialog boxes appear click Yes to change the boundary type. Then 

click OK to accept "centerline" as the zone name.  
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Pipe Wall Boundary Condition 

First, select Wall in the Boundary Conditions menu, as shown below.

 

 

As can be seen in the image above the Type should have been automatically 

set to wall. If the Type is not set to wall, then set it to wall. Now, no further 

changes are needed for the wall boundary condition.  

Save 

In order to save your work (Click)File > Save Project  as shown in the 

image below.  
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Step 5: Solution 

Second Order Scheme 

A second-order discretization scheme will be used to approximate the solution. 

In order to implement the second order scheme click on Solution 

Methods then click on Momentum and select Second Order Upwind  as 

shown in the image below.  

 

 

Set Initial Guess 

Here, the flow field will be initialized to the values at the inlet. In order to carry 

out the initialization click on Solution Initialization, Standard 

Initialization, and click on Compute from and select inlet as shown 

below.  
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Then, click the Initialize button, . This completes the initialization. 

Set Convergence Criteria 

FLUENT reports a residual for each governing equation being solved. The 

residual is a measure of how well the current solution satisfies the discrete 

form of each governing equation. We'll iterate the solution until the residual for 

each equation falls below 1e-6. In order to specify the residual criteria (Click) 

Monitors > Residuals > Edit... , as shown in the image below.  
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Next, change the residual under Convergence 

Criterion for continuity, x-velocity, and y-velocity, all to 1e-6, as can 

be seen below.  

 

 

Lastly, click OK to close the Residual Monitors menu. 
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Execute Calculation 

Prior, to running the calculation the maximum number of iterations must be set. 

To specify the maximum number of iterations click on Run Calculation then 

set the Number of Iterations to 1000, as shown in the image below.  

 

 

As a safeguard save the project now. Now, click on Calculate two times in 

order to run the calculation. The residuals for each iteration are printed out as 

well as plotted in the graphics window as they are calculated. After running the 

calculation, you should obtain the following residual plot.  
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The residuals fall below the specified convergence criterion of 1e-6 in about 

473 iterations, as shown below. Actual number of convergence steps may vary 

slightly.  

 

 

At this point, save the project once again.  
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Step 6: Results 

The results steps shown below are for the CFD-Post postprocessor that is 

included in ANSYS Workbench.  

Velocity Vectors 

One can plot vectors in the entire domain, or on selected surfaces. Let us plot 

the velocity vectors for the entire domain to see how the flow develops 

downstream from the inlet and redevelops from the expansion entrance. First, 

click on Graphics & Animations. Next, double click on Vectors which is 

located under Graphics. Then, click on Display. Zoom into the region near the 

inlet. The length and color of the arrows represent the velocity magnitude. The 

vector display is more intelligible if one makes the arrows shorter as follows: 

Change Scale to 0.4 in the Vectors menu and click Display. 

The laminar pipe flow was modeled asymmetrically; however, the plot can be 

reflected about the axial axis to get an expanded sectional view. In order to 

carry this out (Click) Display > Views... as shown below. 

 

Under Mirror Planes, only the axis (or centerline) surface is listed since that 

is the only symmetry boundary in the present case. Select axis (or centerline) 

and click Apply, as shown below. 
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Then click Close to exit the Views menu. Your vector field should have been 

reflected across the axially axis as, shown below. 

 

The velocity vectors provide a picture of how the flow develops downstream 

from the inlet and redevelops from the expansion entrance.  

Centerline Velocity 

Here, we'll plot the variation of the axial velocity along the centerline. In order 

to start the process (Click) Results > Plots > XY Plot... > Set Up.. as shown 

below 
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In the Solution XY Plot menu make sure that Position on X Axis is selected, 

and X is set to 1 and Y is set to 0. This tells FLUENT to plot the x-coordinate 

value on the abscissa of the graph. Next, select Velocity... for the first box 

underneath Y Axis Function and select Axial Velocity for the second box. 

Please note that X Axis Function and Y Axis Function describe the x and y 

axes of the graph, which should not be confused with the x and y directions of 

the pipe. Finally, select centerline under Surfaces since we are plotting the 

axial velocity along the centerline. This finishes setting up the plotting 

parameters. Your Solution XY Plot should look exactly the same as the 

following image. 
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Now, click Plot. The plot of the axial velocity as a function of distance along the 

centerline now appears. 

 

In the graph that comes up, we can see that the velocity reaches a constant 

value (about 5.25e-1 m/s) beyond a certain distance from the inlet. This is the 

fully-developed flow region in the small pipe. When the flow pass the 

expansion entrance at x=0 m, the velocity will decrease due to the sudden 

expansion of the pipe. After another development, the velocity will reach a 

constant value (about 1.5e-1m/s) again. 

Saving the Plot 

In this section, we will save the data from the plot and a picture of the plot. The 

data from the plot will be saved first. In order to save the plot data open the 

Solution XY Plot menu and then select Write to File, which is located under 
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Options. The Plot button should have changed to Write.... Click on Write..., 

and then enter vel.xy as the XY File Name. Next, click OK. Check that this 

file has been created in your FLUENT working directory. Lastly, close the 

Solution XY Plot menu.  

At this point, we'll save a picture of the plot. First click on File then click Save 

Picture, as shown below. 

 

Under Format, choose one of the following three options: EPS, TIFF, or JPG. 

After selecting your desired image format and associated options, click on 

Save... Enter vel.eps, vel.tif, or vel.jpg depending on your format 

choice and click OK. Verify that the image file has been created in your 

working directory. You can now copy this file onto a disk or print it out for your 

records. 
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Step 7: Verification & Validation 

It is very important that you take the time to check the validity of your 

solution. Based on the velocity profile along the centerline, it can be seen that 

the max axis velocity in the small pipe is about 5.25e-1 m/s. However, in a 

full-developed laminar pipe flow, the analytical max axis velocity should be two 

times of the uniform inlet velocity, that is 5.54e-1 m/s. In other words, the 

results with the previous mesh are not good enough. 

Refine Mesh 

Let's repeat the solution on a finer mesh. For the finer mesh, the numbers of 

radial divisions will be twice as many as those used before. In 

the Workbench Project Page  right click on Mesh then click 

Duplicate as shown below.  

 

Rename the duplicate project to suddenExpansion (mesh2). You should 

have the following two projects in your Workbench Project Page .  
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Next, double click on the Mesh cell of the suddenExpansion 

(mesh2) project. A new ANSYS Mesher window will open. Under Outline, 

expand Mesh and click on Edge Sizing, as shown below.  

 

Here we will increase the numbers of cells in the radial direction. You may 

have different names of sizings. In my case, the "Edge Sizing" corresponds to 

the AB and EF edges, and “Edge Sizing 4” corresponds to the CD edge. 

Double the Number of Divisions of “Edge Sizing”  

 

and “Edge Sizing 4” 
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Sometimes, you need to turn-off "Advanced Size Function" under "Details of 

Mesh" to get the mesher to accept the modified settings. That way the 

Advanced Size Function feature will not over-ride your settings (this feature is 

useful for meshing complex geometries). Click Mesh in the tree and turn off 

Advanced Size Function under "Details of Mesh" as shown below.  

 

Then, click Update to generate the new mesh.  

 

The mesh should now have 44000 elements. A quick glance of the mesh 

statistics reveals that there are indeed 44000 elements.  
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Compute the Solution 

Close the ANSYS Mesher to go back to the Workbench Project Page . 

Under suddenExpansion (mesh2), right click on Fluid Flow 

(FLUENT) and click on Update, as shown below.  

 

 

Now, wait a few minutes for FLUENT to obtain the solution for the refined 

mesh. After FLUENT obtains the solution, save your project.  

It is necessary to check that the solution iterations have converged. Launch 

FLUENT by double clicking on Solution of the "suddenExpansion 

(mesh2)" project in the Workbench Project Page . After FLUENT 

launches, select Monitors > Residuals > Edit...  and then Plot, as shown 

in the images below.  
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If the solution hasn't converged, one needs to run more iterations by 

selecting Run Calculation. You may want to increase the number of 

iterations. Ensure that you have a converged solution and save the 

project.  Then, if you double-click on Results for mesh2 in the project page, 

you'll see that all results have been updated for the new mesh.  

 

Velocity profile 

The plot below shows the profile of the axial velocity along the centerline (y = 0 

m) with the refined mesh. It can be seen that the max velocity in the small pipe 

is about 5.50e-1 m/s, which is close to the analytical solution (5.54e-1 m/s) and 

better than that of the previous mesh. 

 

https://confluence.cornell.edu/download/attachments/85624049/monitors.png?version=1&modificationDate=1363973454000
https://confluence.cornell.edu/download/attachments/85624049/monitors2.png?version=1&modificationDate=1363973459000
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Here we will create a straight line for the expansion entrance, which is from (x0, 

y0) = (0, 0) to (x1, y1) = (0, 1). Select Line under Surface. Enter x0 = 0, y0 

= 0, x1 = 0, y1 = 1. Enter expansion under New Surface Name. 

Click Create.  

 

Then, plot the velocity profile along the expansion line. In the Solution XY 

Plot menu make sure that Position on X Axis is selected, and X is set to 0 

and Y is set to 1. 
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Then, click Plot and you should obtain the following output.  

 

You can also plot axial velocity profiles at x = 1 m, 2 m, 3 m, 4 m, 5 m and 6 m 

as shown below. The numbers of the lines also indicate the distances from the 

expansion entrance to these lines.  
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As you can see from the velocity profiles, the end of the recirculation region is 

at x = 5 m. In other words, the recirculation length for Re = 55.4 is about 5 

times of the inlet radius, which agree well with the experimental data (Hammad 

et al., Experiments in Fluids, 1999, 26:266-271) shown below.  

 

Streamline 

First, click on Graphics & Animations. Next, double click on Contours which 

is located under Graphics. Select Velocity and Stream Function under 

Contours of, and change the number of Levels to 50, as shown blow. 
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Then, click on Display. Zoom into the region near the expansion. The 

streamlines calculated with FLUENT are presented blow, and compared with 

the streamlines obtained via PIV experiment (Hammad et al., Experiments in 

Fluids, 1999, 26:266-271). It can be seen that the numerical result agree with 

the experiment one.  

 

 

For more strict comparison, one should export the results from FLUENT, 

re-plot it in TECPLOT or some other post-processing software, and compare 

the value of stream function, redevelopment length and recirculation length 

carefully. One can also increase the inlet velocity so that Re = 200, and then 

compare the results with experiment data presented in the reference. 


